
DOCUMENT RESUME

ED 405 831 IR 018 271

AUTHOR Snyder, Michelle
TITLE The Paperless Writing Course: A Relevant Business

Writing Course.
PUB DATE 96

NOTE 7p.; In: Association of Small Computer Users in
Education (ASCUE) Summer Conference Proceedings
(29th, North Myrtle Beach, SC, June 9-13, 1996); see
IR 018 247.

PUB TYPE Reports Descriptive (141) Speeches/Conference
Papers (150)

EDRS PRICE MFO1 /PCO1 Plus Postage.
DESCRIPTORS Assignments; Computer Uses in Education; Educational

Technology; *Electronic Text; *Error Correction;
Feedback; Nonprint Media; Teacher Student
Relationship; *Word Processing; *Writing
Instruction

IDENTIFIERS Lotus Ami Pro; Microsoft Word

ABSTRACT
In an age when the paperless office is fast becoming

a reality, the need for a paperless writing course has arisen. This
paper presents an easy and inexpensive way to design a paperless
writing course by taking advantage of the annotation feature
available on many word processors, such as Microsoft Word or Lotus
Ami Pro. The annotation feature allows users to insert messages or
comments into a document; the instructor can use this feature to
direct the student's attention to an error to be corrected. The
experimental course began with a review of the basics of the word
processor, then shortcut keys, and finally the annotation feature.
The instructor lectured on some aspect of writing for the first half
of each scheduled class meeting; the latter half of the class period
was used to teach the students how to use certain features of the
word processor that supported the lecture given during the first
portion of the class. Students completed homework assignments and
turned them in to the instructor on floppy disks. The instructor then
reviewed the students' writings, annotating any errors, and then
returned the annotated disks to the students. The paperless writing
course proved to be effective in allowing the instructor and student
greater flexibility in creating and meeting assignment deadlines and
promoting better, more efficient communication flow between student
and teacher. (AEF)

***********************************************************************

Reproductions supplied by EDRS are the best that can be made
from the original document.

***********************************************************************



1996 ASCUE Proceedings
r

The Paper less Writing Course:
A Relevant Business Writing Course

Michelle Snyder
Lord Fairfax Community College
P.O. 47 Middletown, VA 22645

(540) 465-3731 ext. 165
michells @ judds.com

Abstract

U.S. DEPARTMENT OF EDUCATION
Office of Educational Research and Improvement

EDUCATIONAL RESOURCES INFORMATION
CENTER (ERIC)

This document has been reproduced as
received from the person or organization
originating it.

Minor changes have been made to
improve reproduction quality.

Points of view or opinions stated in this
document do not necessarily represent
official OERI position or policy.

"PERMISSION TO REPRODUCE THIS
MATERIAL HAS BEEN GRANTED BY

C.P. Singer

TO THE EDUCATIONAL RESOURCES
INFORMATION CENTER (ERIC)."

In the age when the paperless office is fast becoming a reality, the need for a paperless writing course
has arisen. This paper will present an easy and inexpensive way to design a paperless writing course
by taking advantage of the annotation feature available on many word processors, such as Microsoft
Word or Lotus Ami Pro. This feature allows users to insert messages or comments into a document.
The ideas presented have been classroom tested and proved effective in allowing the instructor and
student greater flexibility in creating and meeting assignment deadlines and promoting better, more
efficient communication flow between student and teacher.

Introduction

The praises of the paperless office are so often sung that it seems that its virtues might also transfer
well into a more academic setting. While many offices and even a few Universities, such as
University of Delaware, have done away with their forms and multiple copies and become essentially
paperless, the manner in which writing is primarily taught has changed little. Writing students still
do much of their in-class compositions with paper and pencil, and are usually encouraged to use a
word processor only when completing a major assignment, such as a term paper or long essay. Due
to the rapid growth of information technology, English composition course textbooks often teach
old-fashioned methods of researching, writing, and taking notes.

This paper will outline a simple, inexpensive, yet effective, means of implementing a paperless
writing course. Only a stand- alone PC, Microsoft Windows, and either Lotus Ami Pro or Microsoft
Word are needed. A networked system can be used, and if the instructor desires, files can be
transferred electronically between instructor and student. However, for the class outlined below this
was not feasible, due to the need for the course to be portable enough to be offered at three different
locations.

"The Paperless Writing Class" is a class offered in a large printing facility by a workplace education
project, jointly funded by a federal grant and three printing companies. Courses offered by the project
are designed to teach print employees the fundamentals of workplace communication and math, as
well as help them upgrade the skills they already possess in an increasingly technologically advanced
work environment.

0.0
A workplace writing course seemed to provide the perfect laboratory setting for the paperless writing
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experiment for several reasons. First the students are constantly in need of learning to use the
computer or at least upgrade their skills. Second, most business professionals already do most of
their composing at the computer, so to make them revert to paper and pencil appears to be an
unnecessary step backwards. Third, the student is able to make corrections quickly and painlessly
without having to recopy the entire document. Finally, this arrangement allows student/teacher
flexibility in arranging meeting times. For example, the student may pick up the annotated disk
before the next class meeting, and make any necessary corrections in order to meet work deadlines.

The students were excited about the idea of a paperless writing course, as this would allow them to
upgrade both their writing skills and their computer skills at the same time. Many of the students had
been wanting to upgrade their computer skills, but did not have time to take a word processing
course. However, some of the students were not computer-literate and were somewhat intimidated
by the idea of taking a course that involved computers. Yet, because the computer was not the single
focus in "The Paper less Writing Course", they were less anxious than they would have been taking
a computer literacy course.

The opportunity to teach students two highly valuable skills concurrently, not to mention the thought
of avoiding writer's cramp from so much editing by hand, was enough to satisfy the writing
instructor. Although courses involving the use of the computer generally require more preparation,
the ability to provide students with the technical skills necessary to improve their job performance
justifies the extra time commitment on the part of the instructor.

Methodology

The annotation feature, rather than the revision tracking feature, was used for this course. The
revision tracking feature was designed to allow a user to track changes made to a document. This
would allow an instructor to revise a student's document, and would allow the student to view the
revisions that the instructor had made. However, it would not ensure that the student understands
why the corrections were made, and would not require him or her to think critically, and to learn
from his or her mistakes.

Instead of using the revision tracking feature to revise student documents, the instructor decided to
use the annotation feature available in Microsoft Word and Lotus Ami Pro to direct the student's
attention to an error to be corrected, and allow the student to correct the error him or herself.
Through use of the annotation feature, an instructor's noting that an error occurred would force the
student to pinpoint the error, understand a particular grammar rule, and, most importantly, use the
rule. This would reinforce the student's knowledge of the English language and, perhaps more
importantly, would require him or her to think. To ensure that the students were indeed displaying
and reading the annotations, they were required to submit a corrected copy of the document to the
instructor.

Lotus Ami Pro's Annotation Feature

The annotation feature allows one or more users to insert
messages or comments into a document. Subsequently, the notes can be read, revised, or removed
by any other person who displays or prints the document. To insert a note into a Lotus Ami Pro
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document text, a table, a header, a footer, or a footnote the user will perform the following steps:

Place the insertion point where the annotation is to be inserted.
Choose "Edit/Insert" from the menu bar and choose "Note", or click the "Insert" icon and
type the text.
Type the note text.
To return to the main document text, press the "Esc" key.

To display a note to read or edit its contents, simply double- click the note mark in the text. A note
can be edited by displaying the note and editing it by inserting, deleting, cutting, copying, or typing
the desired text. Finally, a note can be removed individually with or without being displayed, and
all notes in a document can be removed simultaneously.

To remove a note without displaying the Note window, place the insertion point on the desired note
mark and press "Delete". A displayed note can be removed by accessing the Control menu box in 1
the Note window and choosing "Remove This Note". Finally, all notes in a given document can be
removed by accessing the Control menu box in the Note window and choosing "Remove All Notes".

Ami Pro allows users to print Notes by performing the following steps:

Choose "File/Print" from the Menu bar.
Select "Options".
Choose "With notes"
Select "OK" to return to the Print dialog box.
Choose "OK" again to print the document with notes.

Ami Pro prints the number of each note in square brackets in the location in the text where the note
exists. On separate pages after the last page in the document, Ami Pro prints the number, initials, and
contents of each note using the font specified in the current body text paragraph style for the notes.

Microsoft Word's Annotation Feature

Microsoft Word's annotation feature has a user interface that is slightly different from that of Ami
Pro. One of the main differences is that while in Ami Pro the annotations appear as tiny,
brightly-colored flags, in Word annotations appear as rather dull sets of brackets containing the
reviewer's initials. However, like the annotation feature in Ami Pro, Word allows one or more users
to insert messages or comments into a document. The notes can then be read, revised, or removed
by any other person who displays or prints the document. To insert a note into a Microsoft Word
document text, a table, a header, a footer, or a footnote perform the following steps:

Select the desired text or item, or position the insertion point at the end of the desired text
or item.
From the Insert menu, select "Annotation".
Type the annotation text in the annotation pane, and choose the "Close" button, or to keep
the annotation pane open to add additional comments, click in the document window, and
repeat the above steps.
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To read or edit annotations in Microsoft Word, the user can either choose "Annotations" from the
View menu, or double-click on an annotation mark in the document window. To see the annotation
marks in Word, the user must click the Show/Hide paragraph markings in the Standard toolbar.
Annotations can be deleted by selecting the annotation mark in the document window and pressing
either the "Backspace" or "Delete" key.

Microsoft Word allows the user to print annotations with or without the document.

To print the document with the annotations:

From the File menu, choose "Print".
In the "Print What" box, select annotations.
Choose the OK button.

To print a document with annotations:

From the File menu, choose "Print".
Choose the "Options" button.
Under "Include With Document", select the "Annotations" check box.
Choose the OK button.
In the Print dialog box, choose the OK button.

Both of the Lotus Ami Pro and Microsoft Word annotation features allow voice annotations to be
inserted; however, because most of the students' computers were not equipped with a sound board,
the use of voice annotations was not feasible for this class.

The Experiment

We began the course by reviewing the basics of using the word processor to create, save, edit, and
print a document. Then we discussed the use of the Menu bar, the Toolbar, and shortcut keys to
perform such tasks as cutting, pasting, and formatting text. (Many other features, such as the
spelling-checker and the thesaurus were discussed during the subsequent sessions.). Afterwards, we
discussed the annotation feature in Ami Pro, its purpose for this class, and how to insert, display,
edit, remove, and print the notes.

The instructor lectured on some aspect of writing for the first half of each scheduled class meeting.
The latter half of the class period was used to teach the students how to use certain features of the
word processor that supported the lecture given during the beginning portion of the class. Then a
follow-up homework assignment to emphasize the concept was be given. For example, if the lecture
highlighted stylistic issues such as the importance of word choice and semantics, the use of the
thesaurus was demonstrated. Then, for their homework assignment, the students were asked to take
a simple narrative and rewrite it to make as complex and incomprehensible as possible, using the
thesaurus to help them accomplish this task. This assignment helped the students to discover
underlying semantic properties of words that, at least on the surface, appear to mean the same thing,
and it drove home the importance of clarity and word choice in writing.
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The students completed the homework assignments and turned them in to the instructor on floppy
disks. The instructor then reviewed the students' writings, annotating any errors, and then returned
the annotated disks to the students. It did not take long for the students to grow accustomed to
reading the annotations or notes in Ami Pro. The notes appear as tiny colored boxes with the editor's
initials adjacent that the user simply selects with a mouse click to open. The student then reads the
note, which should be placed strategically close to the error. The challenge for the student is to recall
the grammar rule or writing concept and correct the error, which is precisely the goal of writing
instruction: to enable the student to comprehend, remember, and use the rules of a language to
produce clear and concise writing.

Because relevancy to the workplace setting is a key element of a successful workplace education
program, many of the homework assignments were directly related to the students' jobs. Because of
this, the flexibility of the instructor in reviewing the students' homework assignments was essential.
If a student submitted an assignment that had a real-world deadline, he or she could communicate
this to the instructor, and the instructor and student could arrange a time when the student could pick
up the annotated disk in order to meet his or her external deadline. Several students regularly turned
in assignments, such as instruction manuals, memos, minutes, and letters, that had real- world
deadlines that occurred before the next class meeting. In all cases, the instructor was able to annotate
the documents and return them to the students to allow them to make the necessary corrections, so
that they could meet their external deadline. These students all expressed how much they appreciated
the opportunity to learn and accomplish work that was relevant to their jobs at the same time.

The student comments made during class and the instructor and class evaluations showed that "The
Paperless Writing Course" briefly outlined above was successful in meeting the goals of the students,
the goals of their-managers, and the goals of the workplace education project. "The Paperless Writing
Course" enabled the employees to improve their basic workplace writing skills and allowed them
to upgrade their computer skills using the work processor available on their own desktop. These
upgraded skills were appreciated by the employees managers, who will benefit from having
better-trained and more highly-skilled employees. The workplace education project staff was pleased
to be able to offer a class which helped them achieve their mission, which is "to deliver workplace
education programs to print industry employees ... [that] will enhance the personal and professional
development of the partners' workforce and instill a desire in the employees for lifelong learning."

Future Directions

Undoubtedly, using annotations for editing purposes is not a brand new idea, but one can take the
concept a step further by automating some of the responses to common errors that students make.
One way of doing this is to use Microsoft WordBasic and a custom dialogue box that contains
controls to help annotate errors by allowing the user to select from a list of commonly used
corrections. For example, a list of corrections might include such commonly committed errors as:
subject-verb agreement, parallel construction, misplaced modifier, and pronoun reference. All of this
can be packaged as an Add-in and loaded automatically from the Windows Program Manager screen
for user convenience. The dialogue box can be accessed from a command button on a toolbar, a
shortcut key, and/or as a menu option.

172



1996 ASCUE Proceedings

The use of a custom dialog box containing controls allows instructors to customize Microsoft Word's
annotation feature and automate error responses, thus alleviating some of the
tediousness and redundancy of correcting papers. The list of error responses can continuously be
added to and updated, whenever a new class of errors has been discovered, therefore eliminating the
need for an exhaustive list of possible errors at the beginning. Using a dialog box to automate error
responses in no way limits instructors to a closed set of error responses, but rather allows them to
avoid retyping responses to the same classes of errors over and over again, while still giving them
the flexibility to enter creative, one-time responses to point out an uncommon error or to praise a
student's brilliant writing.

Another custom feature that would make the system more useful to the instructor would be to create
a log of students and to have the ability to track the number of annotations or corrections in each
document submitted by a student. This would allow the instructor to quantitatively assess a student's
progress, depending on the course design and nature of the assignments. In addition, the nature of
the annotations or corrections could be tracked and used by the instructor to help the student pinpoint
and strengthen his or her weak areas.

By their very nature, courses that involve the computer typically require considerably more time for
preparation, while writing courses typically require more time for homework correction. Automating
the error responses by using a custom dialog box containing controls as outlined above will allow
the instructor of a course composed of a marriage of computers and writing to avoid some of the
more tedious and redundant aspects of correcting student documents. This will free the instructor
to expend more creative energy on course preparation, rather than being bogged down with repetitive
keystrokes.
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